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Copy G/L Accounts 

Copy G/L Accounts and Copy G/L Accounts Setup are Productivity Tools Enterprise Programs 

Note that the Copy G/L Accounts and Copy G/L Accounts Setup icons will appear only if you have an 
Enterprise License for TaiRox Productivity Tools. 

Productivity Tools Enterprise manages the setup and copying operations needed to support a multi-

company general ledger. Segment filtering and substitution rules are defined per target company and 
stored in a template company's database. Based on those rules, you can add new accounts to all target 
companies in a single step. 

Account copying rules are very flexible, letting you specify different ranges of accounts for each target 

company, substitute account segment codes in target companies, and exclude any number of accounts.  

Copied account information also includes the optional field lists from the source account, the members of 

rollup accounts, account allocation information, and multicurrency information if copying between 
multicurrency ledgers. 

You create and maintain the rules for copying accounts with the Copy G/L Accounts Setup program. 
Once the rules are set up, you can add or change accounts in the template company and copy those 
accounts to all target companies in a single operation. 

Note: Copy G/L Accounts does not copy optional field definitions to the target companies. The field 
definitions must first be added in Common Services and in the General Ledger in target companies. 
You can use Copy Company to copy optional field definitions to target companies, or manually add 
them if the optional field lists are different in the template and the target companies. 

You create and maintain the rules for copying accounts with the Copy G/L Accounts Setup program, 

which is described in Appendix A of this guide.  

For details on setting up Copy G/L Accounts, see “Appendix A: Copy G/L Accounts Setup”. 

For examples of account copying, see “Appendix B: Copy G/L Accounts Examples”. 

Running Copy G/L Accounts  

The Copy G/L Accounts icon appears under TaiRox Productivity Tools > General Ledger Tools on the 
Sage 300 desktop and can be copied to other menu locations. 

 
Enterprise Productivity Tools appear if you have an Enterprise license from TaiRox Software. 
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Before you copy accounts: 

• Use the Copy G/L Accounts Setup program to: 
o Set up the rules for copying accounts and substituting account segment codes.  
o Preview the accounts that will be copied or updated by Copy G/L Accounts. 

• Check that the source company’s general ledger passes Sage’s integrity test. 

• Check that a current backup exists for all databases that you are updating. 

• Make sure your User ID has sufficient rights to update all target general ledgers:   

o You must enter a User ID and Password to copy G/L account information. Make sure that the 
User ID has sufficient rights to complete the operation in all target companies.  

Log in as ADMIN to the Sage 300 “Template” company for copying accounts 

In Sage 300, log in to the company database that contains the accounts that you want to copy to other 
company databases.  

Typically, users create a template company that contains all of the general ledger accounts and G/L 
optional fields that they want to copy. The template company typically has no transactions. See 
Appendix A: Copy G/L Accounts Setup for guidelines on creating a template company. 

You should log in to Sage 300 using the ADMIN account or using another ID with sufficient rights to add 

or update G/L accounts in all target companies.  

Open TaiRox Productivity Tools > General Ledger Tools > Copy G/L Accounts 

  

 

Select whether to insert new accounts or update existing ones in target 
companies: 

Before proceeding, you must decide whether to add or update accounts in the target companies.   

For example, choose Update Only to update account descriptions for all accounts. 

 



Copy G/L Accounts Running Copy G/L Accounts 

TaiRox Productivity Tools for Sage 300  3 

© 2009-2024 TaiRox Software Inc. All rights reserved.  

• Choose whether to insert, insert and update, or just update G/L accounts in target companies.  

o Insert Only will add accounts if the accounts do not already exist in target companies. It will 
not change existing accounts. 

New accounts include the optional field lists from the template account, the members of rollup 
accounts, allocation information, and, optionally, multicurrency information if copying between 
multicurrency ledgers. 

o Update Only will only update accounts in target companies that already exist – but not add 

new ones. 

Updating includes changes to optional field lists, rollup accounts, allocation information, and, 

multicurrency information.  

Note:  The program will not remove optional fields that contain data from accounts. 

If updating accounts only, you can also choose to update the description only. 

− Update Account Description Only appears for Update Only.  

This checkbox will change account descriptions only – it doesn’t matter whether other 
account properties match. It will not change optional field lists, rollup accounts, allocation 
information, and, multicurrency information 

The “Include Account Multicurrency Information” choice disappears if you choose 

“Update Account Descriptions Only”. 

o Insert and Update will add new accounts and update existing ones. 

Insert and update operations copy account and transaction optional fields information from 
the source accounts to the target accounts, as well as copy control account, account rollup, 
and account allocation information.  

Note that the optional fields must exist in the target companies before they can be added to 

accounts.  

“Include Multicurrency Information” options: 

Do not select “Include Multicurrency Account Information” if copying accounts from a 
Multicurrency template ledger to a Single Currency ledger 

The program will not copy any accounts from a multicurrency general ledger to a single current 

general ledger if you choose the option to Include Account Multicurrency information. 

You should do two separate processing runs – one targeting multicurrency ledgers and one targeting 

single currency ledgers if you are copying account data for multicurrency accounts to multicurrency 
and single currency ledgers,  

You may also prefer to create two template companies, one targeting single-currency ledgers and 
one targeting multicurrency ledgers. 

Additional options if you include multicurrency information: 

 

• Set Account Default Currency to Target Company’s Function Currency. 

This option lets you copy multicurrency accounts to a G/L that has a different functional currency. 

For example, if you copied accounts to a target company with functional currency CAD, the 
default currency for each copied account would be set to CAD – as above. 
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If you do not select this option, the program will copy the default currency for the source account 
to the target company. 

• Allow Posting in All Currencies. 

This option selects the “Post in All Currencies” option in the target company for all copied 
accounts. 

If you do not select this option, the program will copy the “Post In” settings from the source 
company – including lists of specified currencies from the source general ledger. (The program 
will add the default currency to the list if it is not there.) 

Note that all multicurrency fields in the target account are ignored if the source account is not 

multicurrency. 

Select target Sage 300 companies: 

If you have a mix of multicurrency and single-currency target companies, perform two 
processing runs 

If you have multicurrency and single-currency target companies, select the “Include Multicurrency 
Account Information” option and select multicurrency target companies for one processing run, then 
start a second processing run, de-select the “Include Multicurrency Account Information” option and 
select single-currency target companies. 

 

• Click the Select All and Select None buttons at the bottom of the form to include all or none of the 
target companies. 

 

• Click the checkboxes to complete your company selections. 

Click the Copy button to copy accounts:  

 

• Click the Copy button to start the copy procedure. 

• Enter your User ID and password in the Sage 300 Sign-On window and click OK. 

Note:  The user ID you specify MUST have sufficient permissions to update G/L accounts in all 

target companies for copying to proceed. 
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• The program will copy the G/L account information to the target companies. 

• If no changes are required for a selected account, no update will be performed – and the audit 
stamp will be preserved. 

• If you cancel the operation during the copying process, you must check the log to see which 
procedures were completed and assess how you want to continue. 

Click the Log button to confirm which companies and G/L accounts were 
processed: 

 

 

The Log lists: 

• The user, the type of operation performed, and the range of accounts.  

• Each account that was processed and whether the accounts were updated or inserted. 
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Appendix A: Copy G/L Accounts Setup 

This appendix describes how to set up your system for copying accounts from a template source 
company database to one or more target databases. The appendix includes the following sections: 

Steps for setting up Copy G/L Accounts 

Create Your Source G/L Company 

Log in to the template company 

Open Copy G/L Accounts Setup and add a new target company 

Add ranges of G/L accounts for copying to the target company 

Filter accounts using ranges of segment codes 

Substitute segment codes when copying accounts 

Specify ranges of excluded accounts 

Using Preview to view accounts that will be copied 

Copy G/L Accounts lets you create and maintain the rules for copying multiple ranges of accounts to any 

number of companies.  

We recommend that you set up a “template company” that contains all of the G/L accounts used by all of 

your company databases, then run Copy G/L Accounts whenever you update the template company. 

Once you are set up, you can add new accounts or update accounts in the template company, then run 

Copy G/L Accounts to update all of your company databases without changing the rules. 

Account Mapping Features for Copying G/L Accounts 

Copy G/L Accounts provides the following features for selecting and copying accounts. You can: 

• Specify multiple ranges of account numbers for each target company. 

• Filter account ranges by segment codes. 

• Substitute account segment codes.  

• Specify ranges of excluded accounts. 

• Preview all accounts that will be copied or substituted by one particular rule, or preview all 
accounts that will be copied, substituted, and excluded by all rules for the target company. 

Examples in this User Guide use account structures and segment codes in Sage 300 sample data. 

Notes regarding segments in account codes: 

 • Copy G/L Accounts does not let you substitute the first segment of a Sage 300 G/L account. 
(This is segment is called the “Account” segment in Sage 300 sample data, and is often called 
the “natural account” segment.) 

 • The account structures in the target databases must match the account structures that you are 

copying from the template database. 

 • The “To” segment codes must exist in the target database. (They will not be created by the 
copy process.) 

  You should also add all “To” segment codes to your template company database, so they will 
appear in the Finder when you are specifying segment substitutions. 
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Steps for Setting Up Copy G/L Accounts 

Step 1 – Create Your Template G/L Company 

We recommend that you create a template general ledger that contains all of your general ledger 
accounts, but has no transactions, and is not used for any accounting purposes. 

To create the template G/L company: 

• Create the new G/L Company database with the same System Database that’s used by your 
other companies.  

Use TaiRox Fast DBTools to create the database and add Database Setup information – or 
create the database in MSSQL Server Management Studio and use Sage Database Setup. 

• Open the new Company database, and activate Common Services.  

o You must specify the functional currency code for the source company, and choose the 

Multicurrency option if any of your target companies are multicurrency companies.  

Copy G/L Accounts will copy accounts from a multicurrency source ledger to multicurrency 

and single-currency target ledgers. 

Note: You cannot change the Multicurrency setting or the functional currency after activating 

the company. 

• Activate all applications in the new template company that are used by your target 
companies so you can add all your control accounts.  

If you do not activate all applications that you use, you cannot set up control accounts properly – 
because you can only choose activated applications for the control account ledger lists.  

• Use TaiRox Copy Company to add G/L accounts to your new template company, as well as 
G/L account segments, G/L segment codes, G/L account structures, and G/L optional fields.  

Copy Company copies the structure of an existing Sage 300 company to a new activated 

company database without copying any transactional data.  

Note: Copy Company copies between multicurrency companies or between single-currency 

companies. This means that the source database for Copy Company must be multicurrency if any 
of your target companies are multicurrency companies.  

 

o Copy the Optional Fields definitions from Common Services, as well as the Optional Fields 
selected for G/L. You also want to copy accounts, segment codes, account structures and 
account security. 
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• Edit your new template company so it has all of the accounts, account structures, 
segment codes, and optional fields that you need. 

Important:  Take the time now to remove accounts and optional fields that you do not use. It’s far 

easier to clean up your template chart of accounts than to fix issues in all of your targets. 

Use TaiRox Optional Field manager to clean up optional fields in your template ledger. 

The Copy G/L Accounts Setup icon appears under TaiRox Productivity Tools > General Ledger Tools 
on the Sage 300 desktop. 

 

If you do not see Copy G/L Accounts and Copy G/L Account Setup in the General Ledger Tools folder for 
TaiRox Productivity Tools, open Productivity Tools Options, and see if the programs are selected.  

 

Step 2 – Log in to the Template Company 

Log in to the template company database – the company with the accounts that you want to copy to other 

company databases. 

Keep in mind that your template company database can be organized in several different ways.  

Template DB example 1 – source G/L contains all accounts for all target companies:  

The template company might include all accounts that exist in all of the target companies. In other 

words, you might see a range of accounts with codes like 4000-100, 4000-200, 4000-300, 4000-400, 
4000-500, 4000-600, and you might copy a different selection of accounts from the template company 
to each target company. 

Template DB example 2 –uses segment substitution to generate accounts for target companies:  

The template company might have a single account representing the different account segment 
codes that exist in different target companies. In other words, you might see an account like 4000-000 
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where segment “000” will be substituted with “200,” “300,” “400,” “500,” or “600” in each of the target 
companies.  

Step 3 – Open Copy G/L Accounts Setup and add a new target company 

 

Type the Company ID for a target company into the Company ID field at the top of the form. 

• The program will display the name of the company database in the field to the right. 

• The “Created On” and “Modified On” dates are for the target company’s copying rules. 

• The “Inactive” check box applies to this company ID. If checked, Copy G/L Accounts will not 
display this company name in the list of selectable target companies. 

Note:  You must type the ID for a new company into the Company ID field. After you add the ID, you 
can use the Finder and navigation buttons to reload the Copy G/L Account rules. 

Step 4 – Add ranges of G/L Accounts for copying to the target company 

 

• First, make sure that you are on the “Accounts Included” tab.  

• Click the Account From column heading to display the Finder. 

Note:  The Finder lists accounts that are in the template company’s general ledger. 

• Select the first account in the range of accounts that you want to copy to the target company. 

• Select the last account in the range that you want to copy.  

For example, the following range specification will copy accounts in the range from “1000” to “9999” 

to the target company.  

 

• You can define a single range for copying all accounts in your ledger, or you can specify a 
number of ranges for copying.  

Use the Insert key to add more lines to the grid. 

• Remember that you are specifying the ranges for the currently selected target company ID only.  

• See Using Preview to view accounts that will be copied to check the range specifications. 
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Filter accounts using ranges of segment codes 

Copy G/L Accounts lets you filter ranges of account codes using account segment codes, so you will 
only copy a specific range of account codes that also have a specific range of segment codes.  

To filter a range of accounts by account segment codes: 

• Select the line in the grid that you want to filter by a segment code, and click the Segment 
Filtering column heading. The Segment Filtering form will appear as below. 

 

Note that segment filtering applies to this range line only. Also note that the Segment Filtering cell 
on the range line will change to “Yes” when you define the segment filtering and close the popup 
form. 

• Click the “Segment” column heading to display the Segment Selection dropdown, then select the 
segment that you want to filter with. 

 

• Fill in the substitution details. The program will validate that the segment has been defined in the 
target company. 

 

You can choose more than one segment for filtering – for example, using Sage 300 sample data, 
you could choose to copy accounts for only one division and only one region to the target 
company. 

• See Using Preview to view accounts that will be copied to check the filtering specification. 

Substitute segment codes when copying: 

This feature lets you copy a group of accounts that have one segment code value in the template 

ledger to a group of accounts with a different segment value in the target ledger.  

Note:  When substituting segments, Copy G/L Accounts lets you copy accounts from the 
template company back to the template company to create a new department, division, or profit 
center. 

You must add new segment values to the target General Ledger before you can copy accounts 
to that segment value.  

For example, if you want to add accounts for new segment code “400” to a company, you must add 
the “400” segment code to the target company before you can copy the accounts or create them 
using segment substitution. All exceptions will be logged. 
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Use TaiRox Extended G/L Segment Codes to copy new segment codes from a source company to 
target companies.  

To perform segment substitution on a range of accounts: 

• Select the line in the grid for which you to substitute segment codes, and click the Segment 
Substitution column heading. The Segment Substitution form will appear as below. 

 

Note that segment substitution applies to this range line only. Also note that the Segment 
Substitution cell on the range line will change to “Yes” when you define the segment substitution 
and close the popup form. 

• Click the “Segment” column heading, then double-click the first cell in the grid to display the 
Segment Selection dropdown. Select the segment that you want to substitute. 

 

• Fill in the substitution details. The program will validate that the segment has been defined in the 
target company. 

Note: You can substitute values for more than one segment; however, you cannot define two 

different substitutions for the same segment in the same rule. If you do, the following message 
will appear: 

 

If you need to define two different substitutions for the same account segment, you must 
specify a second range of accounts on the “Accounts Included” tab, then specify the second 
segment substitution. 

• Close the form when you are finished. The cell for Segment Substitution will now be “Yes”, and 
you can click the column heading to edit the substitution settings. 

• See Using Preview to view accounts that will be copied to check which accounts will be copied 
with segment substitution. 
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Specify ranges of excluded accounts  

Copy G/L Accounts lets you exclude groups of accounts from the ranges that you specified on the 
“Accounts Included” tab. 

To exclude accounts from the “included” range of accounts: 

• First, make sure that you are on the “Accounts Excluded” tab.  

• Click the Account From column heading to display the Finder. 

 

• Select the accounts/account ranges that you want to exclude from the copying process. 

For example, the following screen shows job costing and Quebec payroll accounts excluded from 

copying to a US retail company database. 

 

• See Using Preview to view accounts that will be copied to view accounts that will be included and 
excluded from the copy operation. 

Step 5 – Use “Preview” to view all accounts that will be copied 

Copy G/L Accounts Setup lets you preview the accounts copied by each rule – and preview the accounts 

that will be copied by all of the rules. 

Note: Use Preview whenever you add new accounts to your template G/L to ensure that the new 

accounts are properly copied – or excluded – by the rules for each target company. 

 

• Click the Preview Accounts column heading to view the accounts that will be copied by the 
highlighted line in the grid. 

• Click the Preview button at the bottom of the screen to view all accounts that will be copied when 
you run Copy G/L Accounts. 
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When you click the Preview column heading – or when you click the Preview button – a second form will 
pop up that lets you choose to preview all accounts, just included accounts, or just excluded accounts. 

You must choose which accounts you want to Preview, and then click the Load button at the bottom of 
the popup form. 

 

Note: 

• The information at the top of the form shows you the range of accounts that the preview applies 
to. In this case, we highlighted line 1 in the grid, which specified a range of account 1000 - 3999. 

• The account range fields will not appear if you click the Preview button at the bottom of the 
screen (because the preview is for all rules). 

• Account previews appear as follows: 

All Accounts -- which means the “Included Accounts” after any filtering as well as the results of 
account substitution, and displays all excluded accounts. 

 

o Copied accounts with no segment substitution appear with a grey background. 

o Substituted accounts appear with a green background, and show the From and To account 

codes. 

o Excluded accounts appear with a yellow background. 

Included Accounts – does not display the excluded accounts. 

Excluded Accounts – only lists the accounts specified on the Accounts Excluded tab. 

• Click the Load button at the bottom of the Preview form to load the accounts that will be copied or 
excluded. 
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Appendix B: Copy G/L Accounts Examples 

This appendix provides several examples of account copying and segment substitution.  

Example 1: Using SAMLTD as the source company, copy accounts to a “Division 100” target company. 

 Involves copying a range of divisions from “   ” to “100”. 

Example 2: Using SAMLTD as the source company, copy accounts to a “Division 200” target company. 

 Involves copying two range of divisions from “   ” to “   ” and from “200” to “200”. 

Example 3: Using SAMLTD as the source company, use account substitution to copy accounts to a 

"Division 300" target company. 

 Involves copying a range of divisions from “   ” to “100” and changing “100” to “300”. 

Example 4: Use account substitution to add accounts for “Division 300” to a template company – by 
copying from the template company to the template company with segment substitution. 

 Involves copying two range of divisions from “   ” to “   ” and from “200” to “200”. 

Example 5 – Copying to multicurrency and single currency target ledgers 

Most examples use SAMLTD – the multicurrency sample company that ships with Sage 300. 

• Accounts have 1, 2, or 3 segments: 

Segment 1 – Account segment – numbered 1000 to 9999 

Segment 2 – Division segment – for example, 100 = Commercial; 200 = Retail 

Segment 3 – Region segment – for example, 10 = Northern; 20 = Southern; 30 = Eastern 

Example 1 – Copy Accounts for “Division 100” to Target Company 
In this example, the template company has two divisions – 100 and 200 – and we are going to copy 
accounts with a blank division number and division 100 to the target company. 

The simplest way to copy all the accounts we need is to add a single rule that copies all accounts from 
division “   “ to “100”. (Or you could use two rules – one to copy accounts with a blank division code and 
one to copy accounts with division code 100.) 

• No segment substitution is required to create account codes for the target company. 

• If necessary, you can exclude particular accounts that don’t apply to the target company. 

Here is the rule for copying all accounts for division “blank” to “100”. 

• Rule 1:  All accounts in the ledger with a division segment range from “blank” to “100”  

o Account Range “1000” to “9999” – to copy all accounts in the ledger that match the filtering 

o Division segment filtering – “   ” to “100” – to copy all accounts that are used by division 100 

Note:  This rule will copy all accounts with 2 or 3 segments that have “100” in segment 2 – which 

means that all accounts with a Region account segment will be included when you copy accounts. 

To restrict your account copying to a specific region: 

• Add the following Region filter to Rule 1:  

o Region segment filtering – “   ” to “   ” – to copy division 100 accounts with a blank region 

• Add Rule 2:  All accounts in the ledger with a division segment “100”  and region “nn” 

o Account Range “1000” to “9999” – to copy all accounts in the ledger that match the filtering 

o Division segment filtering – “100” to “100” – to filter accounts with a division 100 segment 

o Region segment filtering – “nn” to “nn” – to copy division 100 accounts with a “nn” region 
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Example 2 – Copy Accounts for “Division 200” to Target Company 

For example 2, you must specify two ranges of accounts – one range to copy accounts with a blank 
division segment and one range to copy accounts with division segment “200”. 

Here are the rules for copying all accounts for division “blank” and division “200”. 

• Rule 1:  All accounts with a single segment.  

o Account Range “1000” to “9999” – to copy all accounts in the ledger with a blank division 

o Division segment filtering – “   ” to “   ” – to copy all accounts with just an Account segment 

• Rule 2:  All accounts for division “100”.  

o Account Range “1000” to “9999” – to copy all accounts in the ledger in division “200” 

o Division segment filtering – “200” to “200” – to copy all accounts that are used by division 200  

Note:  Like in Example 1, Rule 2 will copy all accounts with 2 or 3 segments that have “200” in the 
Division segment – which means that all accounts with any Region account segment will be included 
when you copy accounts. 

To restrict your account copying to a specific region: 

• Add the following Region filter to Rule 1 to restrict account to region “  ”:  

o Region segment filtering – “   ” to “   ” – to copy division 200 accounts with a blank region 

• Add Rule 3 to copy the region segment you want:   

o Account Range “1000” to “9999” – to copy all accounts in the ledger that match the filtering 

o Division segment filtering – “200” to “200” – to filter accounts with a division 100 segment 

o Region segment filtering – “nn” to “nn” – to copy division 100 accounts with an “nn” region 

Example 3 – Use Segment Substitution to Copy Accounts from 
SAMLTD to “Division 300” in a Target Company 

For example 3, you must specify two ranges of accounts – one range to copy accounts with a blank 
division segment and one range to copy accounts with division segment “200” to division “300” in the 
target company. 

Here are the rules for copying all accounts and substituting division “200” to division “300”. 

• Rule 1:  All accounts with a single segment.  

o Account Range “1000” to “9999” – to copy all accounts in the ledger with a blank division 

o Division segment filtering – “   ” to “   ” – to copy all accounts with just an Account segment 

• Rule 2:  All accounts for division “200 and substituting “300” as the division number.  

o Account Range “1000” to “9999” – to copy all accounts in the ledger in division “200” 

o Division segment filtering – “200” to “200” – to copy all accounts that are used by division 200  

o Division segment substitution – “200” to “300” – to copy all accounts with division code “200” 

to division code “300” in the target G/L. 

Note:  Like in previous examples 1, Rule 2 will copy all accounts with 2 or 3 segments that have 

“200” in the Division segment – which means that all accounts with any Region account segment will 
be included when you copy accounts. 
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To restrict your account copying to a specific region: 

• Add the following Region filter to Rule 2 to restrict accounts to region “  ”:  

o Region segment filtering – “  ” to “  ” – to copy division 200 accounts with a blank region 

• Add Rule 3 to copy the region you want:   

o Account Range “1000” to “9999” – to copy all accounts in the ledger that match the filtering 

o Division segment filtering – “200” to “200” – to filter accounts with a division 200 segment 

o Region segment filtering – “nn” to “nn” – to copy division 200 accounts with an “nn” region 

o Division segment substitution – “200” to “300” – to copy all accounts with division code “200” 
to division code “300” in the target G/L. 

Example 4 – Use Segment Substitution to Create a New "Division 
300" in the SAMLTD Template 

Suppose we have two divisions in our template company – 100 and 200 – and we want to create a new 
division 300 in the template G/L, and then copy the new division to multiple target companies. 

Copy G/L Accounts lets you use segment substitution to create the new division in your template G/L. 

Step 1: Add a new division code using TaiRox Extended G/L Segment Codes 

First you must add the new Division code to the template company’s general ledger and to all general 

ledgers to which you want to add the new division accounts. 

• Use TaiRox Extended G/L Segment Codes to add the new division to the template company. 

• Then click the Copy Segment Codes button to copy the new segment code to all target G/Ls. 

• Check the Log file to confirm that the segment codes were copied. 

Step 2: Specify the range of accounts to duplicate in the template G/L to the 
create the new division accounts 

The second step is to specify the accounts for an existing division that you want to copy to create the 
new division. Your template company will be both the “source” G/L and the “target” G/L for the copy 
procedure. 

Note these points in the following screen: 

• The rules will copy acccounts from the template G/L to the same template G/L. 

• In our example, the range of accounts is from 3200 to 9999. 

• Only accounts with a division segment “100” are being selected. 

• Accounts with division segment 100 are being copied to the template with division segment “300”. 
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• Rule 1:  Copy all accounts with a division code “100” and substitute division code “300”.  

o Account Range “3200” to “9999” – to copy all accounts in the ledger with a blank division 

o Division segment filtering – “100” to “100” – to copy all accounts with division code “100” 

o Choose Segment Substitution and specify From code “100” To code “300” 

Step 3: Run Copy G/L Accounts to create all accounts for division 300 in the 
template G/L 

• Select “Include Account Multicurrency Information” if your G/L is multicurrency. 

• Select the template G/L as the target company. 

• Check the Log file to confirm that the accounts were copied. 

Step 4: Check/Update the rules for all companies to which you want to copy the 
new division accounts 

You must now check/update the copy rules for each of your target companies to make sure they copy 

the new division accounts to all companies that require them.  

For example, if you filtered accounts by division, you will have to update your rules to add the new 

division to any target companies where you want them copied. 

Step 5: Run Copy G/L Accounts to copy division 300 to target ledgers 

• Select “Include Account Multicurrency Information” for multicurrency target companies. 

• Select the target companies. Do two runs if some companies are single currency and some are 
multicurrency. 

• Check the Log file to confirm that the accounts were copied.  
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Example 5 – Copying to Multicurrency and Single-Currency 
Target Ledgers 

Copy G/L Accounts lets you easily copy account information from a multicurrency chart of accounts to 
multicurrency target ledgers and to single currency target company ledgers. 

However, since you cannot copy multicurrency account information to single-currency ledgers, you must 
do two separate copying runs to fully update your target ledgers. 

Note:  If you have multicurrency and single-currency target ledgers, you may find it simpler to have 
separate multicurrency and single-currency template G/Ls. 

To copy to multicurrency and single currency target company ledgers from a single template: 

• Specify the rules for copying accounts to each target ledger. 

• Run Copy G/L Accounts twice:  

1 – Copy accounts to single currency target ledgers. 

o Do not select “Include Account Multicurrency Information” 

o Select all single currency target companies for copying accounts. 

o Click the Copy button to run the copy procedure. 

2 – Copy accounts to multicurrency target ledgers. 

o Select “Include Account Multicurrency Information” 

− Select “Set Default Currency to Target Company’s Functional Currency” 

This is useful if your target companies are in more than one country. 

− Select “Allow Posting in All Currencies” 

Also useful if your target companies are in more than one country. 

o Select all multicurrency target companies for copying accounts. 

o Click the Copy button to run the copy procedure. 
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Appendix C: Issues with Auto Allocation, 
Rollup, Multicurrency, Control Accounts, 
and Optional Fields 

This appendix describes how Copy G/L Accounts copies auto allocation accounts, rollup accounts, 
multicurrency accounts, and control accounts. 

It also provides information on copying and updating optional fields. 

Auto Allocation Accounts 

An auto allocation account includes a list of accounts to which the account balance and/or account 

quantities can be periodically distributed to other accounts, based on an account list on the Allocation 
tab on the G/L Accounts screen. 

The details of auto allocation accounts are copied to target ledgers in two passes: 

• Pass 1 creates/updates the allocation account in the target ledger. 

• Pass 2 creates/updates the distribution list.  

Two passes are necessary, because all the accounts in the list must exist in the target company 

for the list to be valid. (The account distribution must add up to 100%.) 

If the distribution list cannot be successfully added on pass 2, the program will add an error message 

to the log file, leave the account in the target company with the Auto Allocation checkbox unselected, 
and continue with the next account. 

Note that required distribution accounts may be missing for several reasons: 

• Accounts may belong to different divisions or regions and may not have been copied to the target 
company. 

• Accounts from the list may be missing due to segment substitution. 

• Accounts may be excluded from the copy procedure – either because of Accounts Included 
account ranges or because they are in a range of excluded accounts on the Accounts Excluded 
tab in Copy G/L Accounts Setup. 

To fix the problem, change the rules for copying accounts so the missing accounts appear in the 

target ledger and run Copy G/L Accounts again, specifying an “Update” procedure. The program will 
select the Auto Allocation option and add the missing distribution list. 

Rollup Accounts 

A rollup account includes a list of accounts whose account balances and/or quantities are 
consolidated in the rollup account to provide a summary. 

Like auto allocation accounts, the details of rollup accounts are copied to target ledgers in two 
passes: 

• Pass 1 creates/updates the rollup account in the target ledger. 
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• Pass 2 creates/updates the list of rolled up accounts.  

Two passes are necessary, because all the accounts in the list must exist in the target company 
for the list to be valid. 

If the rollup list cannot be successfully added on pass 2, the program will add an error message to the 
log file, leave the rollup account in the target company with the Rollup checkbox unselected, and 
continue with the next account. 

Note that required rollup accounts may be missing for several reasons: 

• Accounts may belong to different divisions or regions and so may not be copied to the target 
company. 

• Accounts may be missing due to segment substitution. 

• Accounts may be excluded from the copy procedure – either because of Accounts Included 
account ranges or because they are in a range of excluded accounts on the Accounts Excluded 
tab in Copy G/L Accounts Setup. 

To fix the problem, change the rules for copying accounts so the missing accounts appear in the 
target ledger and run Copy G/L Accounts again, specifying an “Update” procedure. The program will 
select the Rollup option and add the missing list of accounts. 

Multicurrency Accounts 

Copy G/L Accounts lets you copy accounts between multicurrency companies and from a 

multicurrency source company to single-currency target companies. 

You must choose “Include Account Multicurrency Information” to create multicurrency accounts in 

target multicurrency ledgers. 

If you include multicurrency information, the program provides two additional options: 

 

• Set Account Default Currency to Target Company’s Function Currency. 

This option lets you copy multicurrency accounts to a G/L that has a different functional currency. 

For example, if you copied accounts to a target company with functional currency CAD, the 

default currency for each copied account would be set to CAD – as above. 

If you do not select this option, the program will copy the default currency for the source account 

to the target company. 

• Allow Posting in All Currencies. 

This option selects the “Post in All Currencies” option in the target company for all copied 

accounts. 

If you do not select this option, the program will copy the “Post In” settings from the source 

company – including lists of specified currencies from the source general ledger. (The program 
will add the default currency to the list if it is not there.) 

Note that all multicurrency fields in the target account are ignored if the source account is not 
multicurrency. 



Issues with Account Settings Control Accounts 

TaiRox Productivity Tools for Sage 300  21 

© 2009-2024 TaiRox Software Inc. All rights reserved.  

Control Accounts 

Control Accounts include a list of subledgers that feed transactions to the control account. The 
Applications for the subledgers must be activated in the target company for them to be added to the 
subledger list. 

If the subledger cannot be successfully added to the list on the Subledger tab, the program will add 

an error message to the log file, add other subledgers that it can, and continue with the next account. 

If the program cannot add any subledgers, the program will leave the subledger checkbox 

unselected, and continue with the next account. 

To fix the problem, activate the applications you require in the target companies and run Copy G/L 

Accounts again, specifying an “Update” procedure. The program will select the Control Account 
option and add the missing list of subledgers. 

Optional Fields for G/L Accounts and G/L Transactions 

Copy G/L Accounts copies the list of optional fields for accounts and transactions fields when it 
copies G/L accounts. 

Note: Copy G/L Accounts does not copy optional field definitions to target companies. The field 
definitions must first be added in Common Services and using the G/L Optional Fields Setup 
program in target companies. You can use Copy Company to copy optional field definitions to 
target companies, or manually add them if the optional field lists are different in the template and 
the target companies. 

If optional fields have not been defined in a target company in Common Services and added to the 

target company’s G/L using the G/L Optional Fields Setup program in the target company, the fields 
cannot be added to copied G/L accounts. 

If an optional field cannot be added to the lists on the Optional Fields and Trans Optional Fields tabs, 
the program will add an error message to the log file, add all of the optional fields that it can, and 
continue with the next account. 

To fix the problem, add optional fields that you require in the target companies and run Copy G/L 

Accounts again, specifying an “Update” procedure. The program will add missing optional fields to the 
Optional Fields and Trans Optional Fields tabs. 

Note: If you remove an optional field from a template account, the program will remove it from target 
ledgers when you run an “update” process unless the field is already in use – in which case, it will 
post a message in the log stating that the field could not be deleted. 
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Appendix D: Exporting and Importing Rules 

You can use the Import and Export commands on the File menu to export the copy/update rules for one 
or more companies. 

This facility allows you to define a set of copy/update rules, export it to Excel, change the Company ID, 
and edit the account ranges and segment substitution information, then import the file to create the rules 
for a new company. 

 

To Export Copy G/L Accounts specifications: 

• Choose File > Export from the Copy G/L Accounts Setup screen. 

• Choose the format for exporting. 

 

• Specify the name of the export file.  

• You can use the Set Criteria screen to select the Company ID that you want to export – as below. 

 

• The Excel spreadsheet includes the data for each company on several tabs. 
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Editing Notes:   

• If you change the ORGID for a company in column A, the ORGID will be updated on other tabs, 
letting you quickly create new rules for additional companies. 

• You must add the additional Company IDs to the Copy G/L Accounts Setup screen before you try 
to import the new profiles. If you do not create the company IDs first, you will get an error 
message like this when you try to import. 

 

To Import Copy G/L Accounts specifications: 

• Choose File > Import from the Copy G/L Accounts Setup screen. 

• Choose the format of the file that you are importing. 

 

• For the next field, the only choice is “Insert”. 

• Specify the name of the import file. You can use the Browse button to find the file. 

• When you tab out of the file name field, the program will validate the source file and show the 
matching file and database fields.  

If you did not export all fields, or if you have modified the spreadsheet that you exported, you may 

have to match up the fields manually. 

• Click OK to load the import file. 
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